Implementation of MIS & FMS In ICAR
(http://icarerp.iasri.res.in)
(http://iasri.res.in/misfms)

User Manual of ICAR ERP Solution
Version 1.0
Release August, 2013

Project Execution BY

Indian Agricultural Statistics Research Institute
Library Avenue, Pusa, New Delhi

ERP Solution Customised By : IBM India Pvt. Ltd.

Indian Council of Agricultural Research
PURCHASING – USER MANUAL DOCUMENT
Implementation of Management Information System (MIS)
Including Financial Management System (FMS)
ICAR
Version: 1.0
Release August' 2013

Consultant: IBM

INDIAN AGRICULTURAL STATISTICS RESEARCH INSTITUTE
(INDIAN COUNCIL OF AGRICULTURAL RESEARCH)
LIBRARY AVENUE, PUSA, NEW DELHI – 110 012
www.iasri.res.in
2013
Mission Leader
DDG (Engg.)

IASRI, New Delhi (Lead Institute)
Director, IASRI
Dr. A. K. Choubey (CPI)
Dr. Alka Arora, Sr. Scientist
Dr. Sudeep Marwaha, Sr. Scientist
Smt. Shashi Dahiya, Scientist
Sh. S. N. Islam, Scientist
Dr. Anshu Bhardwaj, Scientist

IBM Team
Sh. Amit Bothra
Sh. Sameer Sachdeva
Sh. Vijay Shah
Sh. Anil Sharma
Sh. Ravi Kant Singh
Sh. Navroz Singh Dhillon
Sh. Pushpendu Roy
Sh. Amarnath
Ms. Sneha Yadav
Sh. Nitin Batta
Sh. Himanshu Garg
Table of Contents

1 LOGGING INTO ORACLE APPLICATIONS ......................................................................................................................................................................................................................................................... 6

2 PURCHASE REQUISITION ......................................................................................................................................................................................................................................................................................... 10
  2.1 REQUISITION CREATION .............................................................................................................................................................................................................................................. 10
  2.2 ENTERING PURCHASE REQUISITION DATA ........................................................................................................................................................................................................................................... 14
  2.3 ENTERING TAXES INTO REQUISITION ........................................................................................................................................................................................................................................... 23
  2.4 PLACING ATTACHMENTS ............................................................................................................................................................................................................................................... 27
  2.5 REQUISITION APPROVAL PROCESS ................................................................................................................................................................................................................................. 33

3 RFQ (REQUEST FOR QUOTATION) .................................................................................................................................................................................................................................................................. 36
  3.1 PROCESS OVERVIEW ......................................................................................................................................................................................................................................................... 36
  3.2 CREATING RFQS ......................................................................................................................................................................................................................................................... 38
  3.3 ADDING SUPPLIERS TO RFQ ................................................................................................................................................................................................................................. 44

4 QUOTATIONS ........................................................................................................................................................................................................................................................................... 45
  4.1 PROCESS OVERVIEW DESCRIPTION ................................................................................................................................................................................................................................. 45
  4.2 CREATING QUOTATIONS ................................................................................................................................................................................................................................. 47
  4.3 QUOTE ANALYSIS AND APPROVAL ................................................................................................................................................................................................................................. 51

5 PURCHASE ORDER ........................................................................................................................................................................................................................................................................... 56
  5.1 STANDARD PURCHASE ORDER FROM A REQUISITION (THROUGH AUTO CREATE) ........................................................................................................................................................................................................................................................................... 56
  5.2 ENTERING TAXES IN PO ......................................................................................................................................................................................................................................................... 65
  5.3 APPROVING THE PURCHASE ORDER ................................................................................................................................................................................................................................. 68
  5.4 MODIFICATION OF PO ......................................................................................................................................................................................................................................................... 73
  5.5 CANCELLING A PO ......................................................................................................................................................................................................................................................... 79
  5.6 RATE CONTRACTS ......................................................................................................................................................................................................................................................... 86
  5.7 APPROVING RATE CONTRACT................................................................................................................................................................................................................................. 92
  5.8 BLANKET RELEASE ......................................................................................................................................................................................................................................................... 95

6 SUPPLIER CREATION ........................................................................................................................................................................................................................................................................... 102
  6.1 SUPPLIER/SUPPLIER SITE CREATION ................................................................................................................................................................................................................................. 102
Shortcut Keys

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Field</td>
<td>F5</td>
</tr>
<tr>
<td>Clear Record</td>
<td>F6</td>
</tr>
<tr>
<td>Save Record</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Duplicate Field</td>
<td>Shift+F5</td>
</tr>
<tr>
<td>Exit</td>
<td>F4</td>
</tr>
</tbody>
</table>

All Yellow Fields are mandatory.
## 1 Logging into ICAR ERP

**Navigation**

- Open the link for the ICAR ERP
  
  - [http://icarerp.iasri.res.in](http://icarerp.iasri.res.in)
  
  - [http://iasri.res.in/misfms](http://iasri.res.in/misfms)
• Enter the Username and password as provided (individual user name/password to be used). Password need to be changed on first time login.
Click on the Purchasing Requisitioner responsibility.
Oracle Applications Home Page

Worklist

From: Aseeja, Mohit
Subject: IARI - Indian Agricultural Research Institute - Blanket Release 15612400675-1 for INR 20.00 requires your approval.
Sent: 04-Apr-2013

From: Aseeja, Mohit
Subject: Purchase Requisition 15612100262 for Aseeja, Mohit (10.00 INR)
Sent: 16-Mar-2013

Tips:
- Vacation Rules - Redirect or auto-respnd to notifications.
- Worklist Access - Specify which users can view and act upon your notifications.

Navigator

IARI Purchasing Requisitioner

- Requisitions/Indent Creation
- Requisition/Indent Summary
- Requisition/Indent Inquiry
- Purchase Order Inquiry
- Purchase Order Summary
- On-Hand Quantity
- Receiving Transaction Summary
- Notifications

These all forms will appear.
2 Purchase Requisition

2.1 Requisition creation

Process Map

START

Material available in Stores?

No

PR Raised by User

PR is sent for Approval

PR goes to next level for approval

Is PR amount within approval limits?

NO

YES

Send Notification to notification summary of Indenter

Send Notification to notification summary of Indenter

PR gets approved

Stop

User would get material issued from Stores using Material issue slip.
### Process Overview Description

- Indent will be raised only when on hand stock availability of a particular item is nil in system. For this Indenter, first has to check stock of item in system using “On-hand availability” form. In case, quantity is nil or not as per requirement, Indenter will punch the requisition in the system.

- While creating Indent, Indenter will enter all mandatory information for creating the purchase requisition viz. item, item description, quantity, delivery date and source of funds information like Plan/Non-Plan/Deposit Schemes etc. in system.

- In case where source of funds is “Plan”, Indenter will specify the EFC items at item level while capturing details.

- In case of Project requisitions, Project related information needs to be filled in the “Project Details” along with the project item.

- Requester would apply the appropriate taxes, in case applicable, on requisition lines. (Optional)

- Requester will submit the completed requisition for the approval by selecting concerned approver from the list.

### Document Numbering

- Purchase Requisition numbering will be automatic & numeric.

- Different Numbering scheme to be used for different Institutes.

   Example: 10112100001: 101: IARI, 12 is the year, 1: PR, 00001 is the serial number of the document.
- Under IARI Purchasing Requisitioner Responsibility → Go to Requisitions/Indent Creation form

- Click on Open
- The India Localized Requisition screen will open.
- Click on “Open”.

Click on Open Button
### 2.2 Entering Purchase Requisition Data

**Oracle Process – Requisitions/Indent Creation - Screenshot and Steps**

- Purchase Requisition screen form will open up
- On this form enter the description. Click on the DFF (Descriptive flexfield field for storing add. Info.) as shown in the screenshot and enter source of funds, scheme code and division name. Press OK. In case, source of funds is Plan Schemes/NEH/TSP, the DFF at the line level needs to be filled.

![Purchase Requisition Screen Form](image)

**Screenshot:**
- **Institute Name:** IARI - Indian Agricultural Research Institute
- **Indent Number:** [Blank]
- **Type:** Purchase Requisition
- **Status:** Incomplete
- **Preparer:** Mr. Mohit Asoeja
- **Source of Funds:** Plan Schemes
- **Scheme Code:** 11201
- **Division Name:** 10004

**Legend:**
- **Enter Source of Funds, Scheme code and Division name.**
Oracle Process –
Requisitions/Indent Creation - Screenshot and Steps

- In Lines Tab as shown, Enter the Item code
- On selecting the Item code, The Item Category, Description and Unit of Measure will get filled in automatically. For Asset and Expense Items, user has to specify the exact description of the material.
- Enter the Quantity and Price of the Item
- Enter Delivery Date of the item.
- Optionally enter the Suggested Supplier name & Site
- At the line level, click the DFF as shown below and enter the Buy Back Amount and EFC Item.
- If buy back is required, user has to enter the Buy Back Amount.
Oracle Process – Requisitions/Indent Creation - Screenshot and Steps

- Choose the item which needs to be procured.

This list will appear based on the values in the header DFF and item chosen. Choose the item which needs to be procured.
The requisition is now in the “Incomplete status”
Save. Requisition number is generated.
- In case of project POs, Source of Funds is 801 (Deposit Schemes)
- After entering line, click on “Project Details” as shown in the screenshot and go to Project tab.
- In case, the item chosen is Asset or Consumable, enter the Project, Major Category, Minor Category, Institute and date.

![Screenshot of the Oracle Purchasing interface showing the entries for Project, Major Category, Minor Category, and Institute Name.]

- **Enter Project**
- **Enter Major category**
- **Enter Minor category**
- **Enter Institute Name**
**Oracle Process – Requisitions/Indent Creation - Screenshot and Steps**

- Click the DFF as show in the screenshot and choose the project item from the list. Project Item will appear based on the project and major category chosen.
- Press ok
- Save.

Click the DFF
• In case, the item chosen is inventorized, provide store information.
• Click on “Project details” as shown in the screenshot.
• Enter the Project and major category.
• Click the DFF and enter the Minor Category and Project Item required. Project Item will appear based on the Project and Major category chosen.
• Press ok
• Save.
2.3 Entering Taxes into Requisition

- Close the Requisition form. The India Localization Requisition form opens up again
- Now we need to add Taxes to the requisition.
- In the Requisitions Localized Form, Click on the “Taxes” button
The Tax Details India Localization window opens up.
This form would be used for adding all India local taxes defined in the system.

<table>
<thead>
<tr>
<th>Line No.</th>
<th>Tax Name</th>
<th>Tax Type</th>
<th>Precedence</th>
<th>Tax Rate</th>
<th>UOM</th>
<th>Qty/Rate</th>
<th>Curr.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>INR</td>
</tr>
</tbody>
</table>

- Inclusive Tax: 0.00
- Exclusive Tax: 0.00

Apply
Discard
Total INR: 0.00
Oracle Process – Entering Taxes into Requisition - Screenshot and Steps

- Select The Tax Name
- Enter the Tax Precedence and the lines to which the tax needs to be applied to.
- Putting a “0” means applying the tax only to the base amount. Putting “0” and “1” means apply the tax percentage to both the base amount and the first Tax Line while putting “1” means apply the tax percentage to the first Tax line.
- Some taxes / freight are applied as a flat amount and not as a tax. For these taxes enter the exact amount of the tax.
- Select the different taxes that need to be applied.
- After Entering the taxes, click on “Apply” button
- Save the record to attach the taxes to the requisition.
Oracle Process –
Entering Taxes into Requisition -
Screenshot and Steps

- Close the Tax window
- Next, Open the Purchase Requisition by hitting the “Open” button
- Note the status of the requisition is currently “Incomplete”
2.4 Placing Attachments

Oracle Process – Placing Attachments - Screenshot and Steps

- Go to View -- Attachments

![Screenshot of Oracle Purchasing interface showing View menu with Attachments option selected]
Oracle Process – Placing Attachments - Screenshot and Steps

- Click on “Document Catalog”

[Image of the Document Catalog interface]

Click here
Oracle Process – Placing Attachments - Screenshot and Steps

- A new form opens up.
- Press Find.
- Press Attach 1.
• Below screen will appear.
• Save.

### General Terms & Conditions:

1. The rates quoted shall be valid for a period of 180 days from the last fixed for the receipt of quotations.
2. The rates quoted for indigenous items shall be delivered at the Division of Plant Protection on FOB basis including everything except S.T. & VAT. S.T. & VAT may be shown separately. For imported items, the rate shall be at FOB basis.
3. Full specifications of the item quoted for shall be given in the prescribed format only alongside illustrated pamphlets, drawings, etc. Where available, wherever possible samples should also be sent.
4. If taxes, duties, or any other charges over and above the rates quoted are recoverable by the purchaser, actuals/percentage of such taxes/duties/charges should be clearly indicated. Please note that this institute is entitled to professional fees as applicable to Education/Research Labs.
• Check if all details of the requisition are fine and hit the “Approve” button.
In the below screen, check the “Forward” box, approver name will appear.
Press OK.
### 2.5 Requisition Approval Process

| Oracle Process – Requisition Approval Process - Screenshot and Steps |

- The approver will Log in to Oracle and click the Notification Summary button.
- All open notifications will be listed
- The approver will click the notification related to the requisition that needs to be approved

![Screenshot](image-url)
- The approver will click the approve button to approve the requisition.
- To forward the requisition to another person without approving, press the "forward" button, select the employee and apply.
- To return the requisition, press the "Reject" button.
- If the approve button was pressed, the requisition will get approved if it falls within the approval limit of that approver or will jump to the next person in the hierarchy.
• Requisition is now in “Approved” state.
3 RFQ (Request for Quotation)

3.1 Process Overview

Process Map

START → PR is raised → PR is sent for Approval → Select PR for Auto-Create of RFQ → Bid RFQ → Standard RFQ → RFO sent to Supplier → END
<table>
<thead>
<tr>
<th>Process Overview Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Approved Purchase Requisition will be available in the Approved Requisition pool</td>
</tr>
<tr>
<td>• PR in Requisition Pool would be used to create RFQ or PO as per the requirement.</td>
</tr>
<tr>
<td>• RFQ will be auto-created by selecting PR lines; system will automatically generate a RFQ number.</td>
</tr>
<tr>
<td>• RFQ type will be selected.</td>
</tr>
<tr>
<td>o Bid RFQs will be used for one time procurement i.e. Standard Purchase Orders.</td>
</tr>
<tr>
<td>o Standard RFQs will be used for contract purchases. i.e. Rate Contracts</td>
</tr>
<tr>
<td>• Due date to receive quotes from suppliers will be entered.</td>
</tr>
<tr>
<td>• Information like Item details quantity, need by date etc from Purchase Requisition would default on RFQ form.</td>
</tr>
<tr>
<td>• In addition to this, buyer would enter the details like quote effective period, Supplier list and additional terms &amp; conditions.</td>
</tr>
<tr>
<td>• Buyer would inform vendor about the RFQ in the system and seek their responses.</td>
</tr>
<tr>
<td>• On getting vendor quotes, Buyer will enter the quotations received from the suppliers into the system.</td>
</tr>
<tr>
<td>• 'Require Quote Approval' check box would be checked by default to enforce quotation approval before it would be used for a Purchase Order.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Document Numbering</th>
</tr>
</thead>
<tbody>
<tr>
<td>• RFQ numbering will be automatic &amp; numeric.</td>
</tr>
<tr>
<td>• Different Numbering scheme to be used for different Institutes/Regional Centers</td>
</tr>
<tr>
<td>• Example: 10112200001: 101: IARI, 12 is the year, 2: RFQ, 00001 is the serial number of the document.</td>
</tr>
</tbody>
</table>
3.2 Creating RFQs

Oracle Process –
Creating RFQs - Screenshot and Steps

- Navigate to AutoCreate window
- Click on “Open”
**Oracle Process**

**Creating RFQs - Screenshot and Steps**

- Press "Clear" button and enter the Requisition number.
- Press Find.

![Screenshot of Oracle Purchasing interface](image-url)
### Oracle Process

#### Creating RFQs - Screenshot and Steps

- In the Auto create Document form, select the Requisition and the line that needs to be converted into an RFQ.
- Set the Document type to “RFQ”.
- Press on the “Automatic button”.

![Auto create Document form](image)

<table>
<thead>
<tr>
<th>Requisition</th>
<th>Line</th>
<th>Item</th>
<th>Rev</th>
<th>Category</th>
<th>Item Description</th>
<th>UOM</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Need-By</th>
</tr>
</thead>
<tbody>
<tr>
<td>15612100257</td>
<td>1</td>
<td>AEOOE01001</td>
<td>EQUIPMENT</td>
<td>Office Equipments</td>
<td>Each</td>
<td>10</td>
<td>20</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Oracle Process –
Creating RFQs -
Screenshot and Steps

- A new form opens
- This will create a Bid RFQ which will be used to create Standard Purchase Orders.
- Press the “Create” button

[Diagram of RFQ creation process]
Oracle Process

Creating RFQs - Screenshot and Steps

- RFQ gets created.
- Clicking on the description field will give the below message.
- Press OK and enter the Description.

Since the Indent amount is less than Rs 15,000/-, Minimum 3 quotations from supplier are optional.
- Change the Status of RFQ to “Active”.
- Enter the Due date and Quote Effectivity dates.
- Save the RFQ.
- To add Suppliers to whom to send the RFQ, click on the ‘Suppliers’ button at the bottom.
3.3 Adding Suppliers to RFQ

Oracle Process – Creating RFQs - Screenshot and Steps

- The RFQ Suppliers Form opens up.
- Select the Suppliers and the supplier site to whom to send the RFQs

![RFQ Suppliers Form](image)

- Once the suppliers are added to the RFQ, close the form.
- The RFQ form opens up again. Save the RFQ.
- Now the RFQ is complete.
- The RFQs are sent to Suppliers by mail, fax etc.
- Suppliers send in their quotes. These quotes need to be entered into the system by making Quotations.
4 Quotations

4.1 Process Overview Description

Process Map

START -> PR is raised -> PR is sent for Approval -> Buyer would select Approved PR to create RFQ -> Select Type of RFQ (Bid, Standard)

Quotation Analysis (Financial) -> Enter Quote into the system (BID, Standard) -> Quotation from Supplier

Send RFQs to Suppliers -> RFQ Created with additional details

Approve best quotation -> Convert quotation to Rate Agreement/Purchase Order

END
<table>
<thead>
<tr>
<th>Process Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Buyer enters the quotations details received from the suppliers into the system.</td>
</tr>
<tr>
<td>• The copy document will be used to copy details from the RFQ onto the quotation</td>
</tr>
<tr>
<td>• Supplier quotes will be entered as the base line of the quote. For multiple quotes from the same supplier, shipments will be used</td>
</tr>
<tr>
<td>• Taxes details sent by the supplier will also be added into the quote.</td>
</tr>
<tr>
<td>• Quotes from all suppliers would to be entered into the system</td>
</tr>
<tr>
<td>• For each shipment line, Purchasing displays the following information: Quotation number, Supplier, Item Number, Item Description, Unit Price, Freight Terms, Payment Terms, and Discount.</td>
</tr>
<tr>
<td>• After performing the complete quotation analysis, L-1 vendor would be identified by competent authority.</td>
</tr>
<tr>
<td>• On getting this information (L-1 vendor finalization), buyer would approve quote from identified L1 vendor. Also comparative analysis would be attached to this approved requisition for document formalities and for future use.</td>
</tr>
<tr>
<td>• Post quote analysis &amp; L1 vendor identification, PO will be auto-created from quotation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Document Numbering</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Quotation numbering would be automatic &amp; numeric.</td>
</tr>
<tr>
<td>• Different Numbering scheme to be used for different Institutes/Regional Centers</td>
</tr>
<tr>
<td>• Example: 10112300001: 101: IARI, 12 is the year, 3: Quotes, 00001 is the serial number of the document.</td>
</tr>
</tbody>
</table>
4.2 Creating Quotations

<table>
<thead>
<tr>
<th>Oracle Process – Creating RFQs - Screenshot and Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Navigate to RFQ’s.</td>
</tr>
<tr>
<td>• Click the “Open” button.</td>
</tr>
</tbody>
</table>

![Screenshot of Oracle Purchasing interface showing RFQ navigation and selection process.](image-url)
Oracle Process – Creating RFQs - Screenshot and Steps

- Query for the RFQ by pressing F11, typing the RFQ number and then pressing Ctrl F11
- Open the RFQ
- ‘Copy Document’ facility can be used to create Quotations from the RFQs.
- Go to Tools -> Copy Document as shown below
Oracle Process – Creating RFQs - Screenshot and Steps

- In the copy Document Window, make the selections as shown in the figure below.
  - Ideally select the “Entire RFQ” to be copied on to the quotation. One can also copy RFQ header / RFQ line to the new quotation.
  - A Bid quotation need to be created to make a standard purchase order
  - Select the supplier from the list attached Earlier into the RFQ
  - The Entire RFQ gets copied and a Bid Quotation gets created.

```
- Similarly copy all the quotations received from all the suppliers attached the RFQ
```
Oracle Process –
Creating RFQs -Screenshot and Steps

- The quotation gets created.
- Change the status of the quotation to “active”
### 4.3 Quote Analysis and Approval

<table>
<thead>
<tr>
<th>Oracle Process – Quote Analysis</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Information from different suppliers is captured in the system.</td>
</tr>
<tr>
<td></td>
<td>• Analyze Quotations window displays quotations for an item from different suppliers.</td>
</tr>
<tr>
<td></td>
<td>• For each shipment line, Purchasing displays the following information: Quotation number, Supplier, Item Number, Item Description, Unit Price, Freight Terms, Payment Terms, and Discount.</td>
</tr>
<tr>
<td></td>
<td>• Approver enters the reasons for approval.</td>
</tr>
<tr>
<td></td>
<td>• After quote analysis, PO will be auto-created from quotation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Navigation</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Navigate to <em>India Local Purchasing -&gt; RFQs and Quotations -&gt; Quote Analysis (Localized)</em></td>
</tr>
</tbody>
</table>

#### Screenshot and Steps

![Screenshot of Oracle Purchasing – Quote Analysis interface](image-url)
Oracle Process – Quote Analysis and approval - Screenshot and Steps

- Query for the quote based on the item and / or RFQ number.

[Image of a screenshot showing a table with columns for Quotation, Supplier, Item, Description, Price Break Line, UOM, and Currency, and a form for finding quotations with fields for Institute, Item, Description, RFQ, Supplier, RFQ Line, and Quotation.

Enter the RFQ number]
• The Analyze Quotations form opens where the quotes from all the suppliers for the RFQ / Item queried can be viewed and compared.

- Compare the quotes and note down the best quote. Also note down the Quote Line.
- Close the Analyze quotations form.
Oracle Purchasing – User Manual Version 1.0

Oracle Process – Quote Analysis and approval - Screenshot and Steps

- Navigate to Quotations (Localized)
- Query and open the quote that was just noted as the best quote.
- Click on Approve button.

Oracle Process – Quote Analysis and approval - Screenshot and Steps

- Navigate to Quotations (Localized)
- Query and open the quote that was just noted as the best quote.
- Click on Approve button.
Oracle Process – Quote Analysis and approval - Screenshot and Steps

- Provide the reason for the approval of the quotation the document type to be created from the quotation
- Click on "Ok"
- The quotation line gets approved

![Screenshot of approval process]

(Note: Quotation lines have been Approved.)
5 Purchase Order

5.1 Standard Purchase Order from a Requisition (Through Auto create)

Process Map

START → Raise PR → Approve PR → Are Quotations Required for PO?

- YES: Follow RFQ quotes & quotation creation process as explained in previous sections
- NO: Approved PO sent to Vendor

Compotent Authority approves the Purchase Order

Captures additional details like Taxes and Terms & Conditions, submit it for approval

Fund control will happen. Commitment encumbrance will be created

Buyer would create PO from a finalized quotation

Is supplier a Foreign Supplier?

Approved PO sent to Vendor

Buyer would capture LC details on PO

Stop
| **Process Description** | • Approved PR would be available in Requisition Pool  
• PO / RFQ would be auto-created depending on requirement.  
• Document details would flow from Purchase requisition to Purchase order on auto creating. Price would flow from the quotation, if RFQ and quote analysis have been used in creating the purchase order.  
• Taxes would flow from the requisition and can also be added in the PO screen at line level  
• Created PO would be sent for approval through the PO approval hierarchy.  
• Fund control (Expenditure Form) would be happen at PO level also automatically.  
• Buyer can take the print out of Approved PO and will send to the Supplier.  
• Based on the PO, the Supplier will ship the goods along with all shipment documents. |
| |  |
| **Document Numbering** | • Purchase Order numbering would be automatic & numeric.  
• Different Numbering scheme to be used for different Institutes/Regional Centers  
• Example: 10112400001: 101: IARI, 12 is the year, 4: PO/BPA, 00001 is the serial number of the document.  
• Setups will be done in Oracle purchasing for automatic document ordering.  
• This will be one time set. The last five digits in the document number will be a running serial number.  
• 4th & 5th digits would be current year and that has to be changed every financial year midnight manually. |
• Navigate to *AutoCreate*

![AutoCreate screen](image)

• Click on Open
In the Form that opens, press the Clear button
Query for the requisition for which a PO needs to be created
Enter the requisition number and Press the “Find” button.
Oracle Process – Standard Purchase Order from a Requisition (Through Auto Create) –

Screenshots and Steps

- The Auto create Document form opens.
- Select the Requisition and the line that needs to be converted into an PO
- Set the Document type to "Standard PO" and the Action type as "Create"
- Press on the “Automatic button”

![AutoCreate Documents](image)

Click on Automatic
Oracle Process – Standard Purchase Order from a Requisition (Through Auto Create) –

**Screenshots and Steps**

- A new form opens
- Enter the Supplier and the Supplier Site
- Press the “Create” button
Oracle Process –
Standard Purchase Order from a Requisition (Through Auto Create) –

**Screenshots and Steps**

- A Standard PO gets created and a Purchase Order number is also generated
- Enter the Description.
Enter the LC number in the PO header field. LC Nos. will appear based on supplier chosen.
5.2 Entering Taxes in PO

Oracle Process – Entering Taxes in PO – Screenshots and Steps

- Click on Purchase Orders Creation and query the PO no.

- Click on “Open”.

Navigator - IAR: Purchasing Section

Functions

Purchase Orders Creation
Purchase Orders (Localized)

- Requisition/Indent Inquiry
- Requisition/Indent Summary
- Purchase Order Inquiry
- Purchase Order Summary
- RFQ’s
- Quotations
- Financial Quote Analysis
- Requisition/Indent Creation

Top Ten List

Open
A new form opens up.

Press F11 and enter the PO no., then press Ctrl+F11.
Oracle Process – Entering Taxes in PO – Screenshots and Steps

- Tax details India localized screen opens up.
- Select The Tax Name
- Enter the Tax Precedence and the lines to which the tax needs to be applied to.
- Putting a “0” means applying the tax only to the base amount. Putting “0” and “1” means apply the tax percentage to both the base amount and the first Tax Line while putting “1” means apply the tax percentage to the first Tax line.
- Some taxes / freight are applied as a flat amount and not as a tax. For these taxes enter the exact amount of the tax.
- Select the different taxes that need to be applied.
- After Entering the taxes, click on “Apply” button.
- Save the record to attach the taxes to the PO.

![Screenshot of Tax Details India Localization](image)

<table>
<thead>
<tr>
<th>Line No.</th>
<th>Tax Name</th>
<th>Tax Type</th>
<th>Precedence</th>
<th>Tax Rate</th>
<th>UOM</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Service Tax 12%</td>
<td>SERVICE</td>
<td>0</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Education Cess on Serv</td>
<td>SERVICE_EDUC</td>
<td>1</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>SH Education Cess on Serv</td>
<td>SERVICE_SH_EDUC</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Inclusive Tax: 0.00
Exclusive Tax: 24.72
Total: INR 24.72
5.3 Approving the Purchase Order

Oracle Process – Approving the Purchase Order - Screenshots and Steps

- After creating the purchase order buyer will submit it for approval.
- Approver will have the options to approve, reject or forward the documents.
- For Purchase Order & Rate Agreement document approvals, position hierarchy would be used.
- Position hierarchy would be based on different positions attached to the employees in the organization.
- Different approval limits will be given to different positions in the organization.
- PO will get approved at appropriate level in PO approval hierarchy.
- After approval, PO can be sent to the supplier.
Oracle Process – Approving the Purchase Order

Screenshots and Steps

- The India Localization Purchase Order form opens up again
- Open the PO again by clicking on the "open" button
- The status is “Incomplete”
- Click on the "Approve" button
Oracle Process – Approving the Purchase Order

Screenshots and Steps

- The "Approve Document" window opens.
- Check the “Forward” box and approver name will appear automatically in Forward To.
- Press OK.

![Screenshot of Approve Document window](image)
If fund check passes successfully, the Purchase order would be submitted in the hierarchy for approval.

Once Submitted for approval, the PO will pass through funds check. Its success will depend on the budget limit. The status of the Purchase order now will be "In Process, Reserved".

Status of PO Changes to In Process.
After the Purchase Order gets approved, the Status of the Purchase order will be "Approved, Reserved".
5.4 Modification of PO

Process Map:

Start → Buyer creates the Purchase Order → Submitted for approval → Competent Authority Approves the Purchase Order → After approval is there a need to modify PO?

- No → PO sent to supplier → Stop
- Yes → Buyer will open the PO to modify → PO Resubmitted for Approval → Competent Authority Re-approves the Purchase Order → Revision of existing PO is created → Stop
Oracle Process –
Modification of PO -
Screenshots and Steps

- Once a Purchase order has been created and approved, it might need some modifications
- Quantity and Price can be modified after unreserving funds
- Other terms such as payment terms and shipment terms can also be modified
- Open an approved PO
• Click on Tools → Unreserve.
Oracle Process –
Modification of PO - Screenshots and Steps

- A new form opens up.
- Click on OK.
• PO status changes to “Requires Reapproval”.
• Click on OK.

PO placed for the following materials.

Decision

Your Budgetary Control action completed successfully.

OK  View Results
- Change the Quantity/Price as per your requirements.
- Save (Ctrl+S).
- Revision number changes from “0” to “1”.
- A message will appear as shown in the below screenshot. Click on “OK”.
- Send the PO for approval by clicking on “Approve” button.
5.5 Cancelling a PO

- Canceling a rejected PO will transfer the indent with the quantity of the PO back to the Auto Create screen.
- Cancellation of a PO cannot be reverted.
- Note the PO number that needs to be close.
- Navigate to "Purchase Order Summary"
Oracle Process – Cancelling a PO - Screenshots and Steps

- Enter the PO No. that needs to cancel.
- Press “Find”.

![Find Purchase Orders Screenshot]

- Enter PO No.
- Press Find
Oracle Process – Cancelling a PO - Screenshots and Steps

- Go to Tools → Control.
Oracle Process – Cancelling a PO - Screenshots and Steps

- Choose Actions “Cancel PO”.
- Press OK.
Oracle Process – Cancellation of a PO – Screenshots and Steps

A message will appear which will ask for confirmation.

Press OK.

[Diagram showing a popup window with options to cancel, close, close for invoice, close for receiving, freeze, and reasons for cancellation. A caution note states: Once the document is cancelled, it cannot be undone. Do you want to proceed?]
Oracle Process – Cancelling a PO - Screenshots and Steps

Cancelling a PO - Screenshots and Steps

Oracle Purchasing – User Manual Version 1.0

Oracle Process – Cancelling a PO - Screenshots and Steps

Oracle Purchasing – User Training Manual Version 1.0
Oracle Process –
Cancelling a PO -
Screenshots and Steps

- The PO gets cancelled and further the status is now "Closed"
## 5.6 Rate Contracts

### Process Map

START → Indenter raise Purchase Requisition → PR submitted to Competent Authority → Competent authority approves the PR → Buyer will create RFQ & Sent to supplier → Quotations Received from supplier & entered in system → Approved Rate Contract sent to Vendor → Competent Authority approves the Rate Agreement → Buyer will create Rate Agreement against the L1 Supplier → Buyer will do the Quotation Analysis and finalize the L1 Supplier → END
### Process Description

- A rate contract will be created for some items when detail of the goods is known which is planned to buy from a specific supplier in a period, but delivery schedules are not known.
- Rate contract will specify negotiated prices for items before actually purchasing them.
- Rate contract will also have to go through an approval hierarchy.
- After Rate Contract agreement is approved then blanket releases can be made.
- The blanket release will be same as a standard PO but will be related to Rate contract.
- Other process like receiving and bill matching will remain same as it is in standard Purchase order.

### Document Numbering

- Blanket Purchase Agreement numbering will be automatic & numeric.
- Different Numbering scheme to be used for different Institutes/Regional Centers.
- Example: 10112400001: 101: IARI, 12 is the year, 4: PO/BPA, 100000 is the serial number of the document.
- Setups will be done in Oracle purchasing for automatic document ordering.
- This will be one time set. The last five digits in the document number will be a running serial number.
- Second two digits will be current year and that has to be changed every financial year midnight manually.
### Navigation
- Navigate to *Purchase Orders India*

### Oracle Process – Rate Contract - Screenshots and Steps
- Click on “Open”
Oracle Process – Rate Contract - Screenshots and Steps

- Select the Document type as “Blanket Purchase Agreement”.

Choose Blanket Purchase Agreement i.e. Rate Contract
Oracle Process –
Rate Contract -
Screenshots and
Steps

- Enter the Supplier name & Site from the LOV
- Enter Ship to Location & Bill to Location.
- Enter Description.
- Enter Source of Funds, Scheme Code and Division in the header DFF as shown below.
Oracle Process – Rate Contract - Screenshots and Steps

- In Lines Tab as shown, Enter the Item code
- On selecting the Item code, The Item Category, Description and Unit of Measure will get filled in automatically. For Asset and Expense Items, user has to specify the exact description of the material.
- Enter the Price of the Item
- Optionally enter the Suggested Supplier name & Site
- At the line level, click the DFF as shown below and enter the EFC Item.
5.7 Approving Rate Contract

Oracle Process – Approving Rate Contract - Screenshots and Steps

- Contract No. gets generated.
- Click on “Approve” button.

![Screenshot of the Oracle Purchasing interface showing the process of approving a rate contract. The screenshot includes a table with columns for Institute, PO, Rev, Supplier, Ship To, Description, etc., and a section for lines with items, type, category, description, UOM, quantity, and price. There is a highlighted area pointing to the Rate Contract No. field.](image-url)
• Check the “Forward” box.
• Approver name will appear automatically.
• Press OK. Rate Contract will be submitted for approval.
Oracle Process – Approving Rate Contract - Screenshots and Steps

• Rate Contract gets approved.

Purchase Orders: 15612400723

- Institute: IARI, Indian Agriculture
- PO, Rev: 15612400723
- Supplier: Ms. NCCF
- Ship To: IARI (MI), New Delhi
- Purchasing Officer: Mohit Aseja
- Description: Blanket Agreement for the following items.

<table>
<thead>
<tr>
<th>Num</th>
<th>Type</th>
<th>Item</th>
<th>Rev</th>
<th>Job</th>
<th>Category</th>
<th>Description</th>
<th>UOM</th>
<th>Quantity</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Goods</td>
<td>AFMF001001</td>
<td></td>
<td></td>
<td>FURNITURE, FIX</td>
<td>Metal Furniture</td>
<td>Each</td>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>

Status: Approved

Contact: Prakash, Mahajan
Currency: INR
Amt Agreed: 0.00
Released: 0.00
5.8 Blanket Release

Process Map

START → Raise PR → PR goes to different level for approval in approval hierarchy and gets approved at appropriate level → Create blanket release (by linking approved PR to established rate contract) and submit for approval in approval hierarchy → Blanket release gets approved at an appropriate level in approval hierarchy → Blanket release sent to supplier to supply the material → END
**Process Description**

- A rate contract will be created for some items/services when detail of the goods is known which is planned to buy from a specific supplier in a period, but delivery schedules are not known.
- You can issue a blanket release against a rate contract to place the actual order. If you use encumbrance accounting, you can encumber each release also.
- To get the material, the user has to raise a purchase requisition.
- Once the purchase requisition come in requisition pool, the buyer can check if the blanket agreement is available or not.
- If the blanket agreement is available then the buyer can make a release for that item.
- The blanket release will also have to go in approval hierarchy for approval and it will get approved at an appropriate level in approval hierarchy.
- Number of release can be made from a blanket agreement as long the agreed amount is not crossed.

**Document Numbering**

- Numbering of Blanket Release will be automatic and will be dependent on the Rate Contract for which the release has been created.
- Different Numbering scheme to be used for different Institutes/Regional Centers
- Example: 10112400001: 101: IARI, 12 is the year, 4: BPA, 100000 is the serial number of the document.
- Setups will be done in Oracle purchasing for automatic document ordering.
- This will be one time set. The last five digits in the document number will be a running serial number.
- 4th & 5th digits will be current year and that has to be changed every financial year midnight manually.
- The last section – “Release Number” is the release number against the rate contract. This will be an automatic serial number.
- Create a standard Purchase Requisition as explained earlier

![Screenshot of Oracle Purchasing interface](image)

**Institute:** IARI - Indian Agricultural Research

**Indent Number:** 15612100371

**Type:** Purchase Requisition

**Preparer:** Mr. Mohit Aseeja

**Total:** INR 20.00

<table>
<thead>
<tr>
<th>Num</th>
<th>Item</th>
<th>Description</th>
<th>UOM</th>
<th>Quantity</th>
<th>Curr</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AFMA001001</td>
<td>Metal Furniture</td>
<td>Each</td>
<td>2</td>
<td>INR</td>
<td>10</td>
</tr>
</tbody>
</table>

**Destination Type:** Expense

**Inenter:** Mr. Mohit Aseeja

**Organization:** IARI - Indian Agricultural Research

**Location:** IARI (M), New Delhi

**Stores:**
Oracle Purchasing – User Manual Version 1.0

Oracle Process – Blanket Release - Screenshots and Steps

- Navigate to AutoCreate window
- Click on “Open”
- The "Find requisition Lines" form that opens. In it, query for the requisition, for which an PO needs to be created
- Enter the requisition number and Press the “Find” button.
- The Auto create Document form opens.
- In the Auto create Document form, select the Requisition and the line that needs to be converted into release.
- Set the Document type to “Blanket Release”
- Press on the “Automatic button”

![AutoCreate Documents Window](image)

- Change Document Type to Blanket Release
• Select the Rate Contract document number. The Release number gets auto generated.
• Release gets Created

Auto Create To Releases - 15612400723-1

Institute: IARI - Indian Agricultural R
PO, Rev: 15612400723 - 0
Release: 1 - 0
Created: 08 APR 2013 18:14

Supplier: M/s NCCF
Site: NEW DELHI
Contact: Prakash, Mahajan
Currency: INR
Total: 200.00

Shipments

<table>
<thead>
<tr>
<th>Num</th>
<th>Line</th>
<th>Shipment</th>
<th>Org</th>
<th>Ship-To</th>
<th>UOM</th>
<th>Quantity</th>
<th>Price</th>
<th>Promised</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td></td>
<td>196</td>
<td>IARI (M), New</td>
<td>Each</td>
<td>2</td>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>

Item: AFM001001 Metal Furniture

Receiving Controls... Agreement Distributions Approve...
Once the Release gets approved, its status changes to “Approved, Reserved” as shown below.

The Release is now complete.
6 Supplier Creation

6.1 Supplier/Supplier site creation

Supplier Creation Responsibility: Central Master Maintenance Team. For detailed creation process, please refer to the Central Master Maintenance Document.

Process Map
### Process Overview

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users in respective departments, in case Supplier is not available in System, would raise a request in Pre-specified Excel Template. IBM would help in preparing this Supplier Creation Template. This Template would mention all the relevant fields that would be required to create Supplier in System.</td>
</tr>
<tr>
<td>User would duly fill this Template and send across this information to Centralized team through Email who would be responsible for creation of Supplier Masters in System.</td>
</tr>
<tr>
<td>Centralized Team on duly verifying this template and after checking the existing Supplier Master would proceed for Supplier Creation in System. In case Supplier is already available in system, Centralized Team would Reply to the Respective User with existing Supplier Details offline.</td>
</tr>
<tr>
<td>On receiving Supplier Template, Centralized Team would proceed for Supplier Creation in System using Supplier Entry Form.</td>
</tr>
<tr>
<td>In case Supplier header exists in the system, centralized team will check whether supplier site exist for the respective institute.</td>
</tr>
<tr>
<td>Based on such inquiry if required site will be created for the supplier.</td>
</tr>
<tr>
<td>Relevant fields would be captured for supplier creation like Supplier Name, Address, Contact Information, Supplier Tax Details, Supplier Bank Details etc.</td>
</tr>
<tr>
<td>After Creation of Supplier, information to be conveyed to Respective user by Centralized Team</td>
</tr>
</tbody>
</table>
Oracle Process – Supplier Creation - Screenshots and Steps

- Navigate to Supply Base ---\(\rightarrow\) Suppliers

![Suppliers Screenshot]

`functions Documents Processes`
Oracle Process – Supplier Creation - Screenshots and Steps

- In the below screenshot, click on “Create Supplier” button.
Oracle Process –
Supplier Creation -
Screenshots and Steps

- Enter Organization name, Tax Country and approved by Institute.
- Approved by Institute – Yes -→ This means that it’s a registered supplier.
- Press Apply.

![Create Supplier Form]

Enter Supplier name

- Organization Name: Oracle India Pvt. Ltd.
- Tax Country: India
- Tax Registration Number
- Taxpayers ID
- Contact Value
- Approved By Institute: Yes

Cancel Apply
Click ‘Address Book” to add address details.
• Fill the information as shown in the below screenshot.

[Image of Oracle Purchasing - Supplier Creation - Screenshots and Steps]

- Address Details:
  - Country: India
  - Address Line 1: DLF Building No 8, Tower C
  - Address Line 2: Ground & 7th Floor
  - Address Line 3: DLF Cyber City, DLF Phase - II
  - City: Gurgaon
  - County: India
  - State: Haryana
  - Province: 
  - Postal Code: 122002

- Contact Details and Purpose:
  - Communication Details: [ ] Update to all new sites created for this address
  - Phone Area Code: 
  - Phone Number: 
  - Fax Area Code: 
  - Fax Number: 
  - Email Address: 
  - Address Purpose: [ ] Purchasing
  - [ ] Payment
  - [ ] REQ Only

- Supplier Name: Oracle India Pvt. Ltd.
- Supplier Number: 149
• Check the box as shown in the screenshot to create Supplier Site.
• Press Apply.

Check this box.
• Supplier gets created.
7 Running Purchasing Reports

**Navigation**

- From the toolbar menu at the top, select View ➔ Request
• Click on "Submit a new Request"
• Select "Single Request" and click "OK"
**Screenshot and Steps**

- Enter the report name and the parameters as per following

<table>
<thead>
<tr>
<th>REPORT NAME</th>
<th>PARAMETERS &amp; EXPLANATION</th>
</tr>
</thead>
</table>
| ICAR Fund Inquiry Report         | • Institute Name: Enter the Institute name from list of values  
                                 | • Source of Fund: Enter the source of funds (Plan/Non Plan)  
                                 | • Scheme: Select the Scheme name  
                                 | Provides the budgeted, encumbered, actual and fund available against a particular head.                                                              |
| ICAR Purchase Order Print Report | • Institute Name: Select the institute from list of values  
                                 | • PO Number: Enter the PO No.  
                                 | Provide the PO print in PDF format.                                                                                                                      |
| ICAR Expenditure Sanction Order Report | • Institute Name: Enter the Institute name from list of values  
                                          | • Quotation No: Enter the Quotation No.  
                                          | Provides the funds availability against a particular head                                                                                                   |
| ICAR Purchase Order Detailed Report | • Institute Name: Enter the Institute name from list of values  
                                           | • Start Date : Enter the start date  
                                           | • End Date : Enter the end date  
                                           | Provides the detailed list of Pos (Line wise) in a particular period along with item code, unit price and quantity.                                         |